


 

 

 

 

 

 

Excel 2023

A Comprehensive Quick Reference Guide to Master All You Need to Know
about Excel Fundamentals, Formulas, Functions, & Charts with Real-World

Examples

 

 

 

 

 

Gary A. Amerson



Copyright © 2023 Gary A. Amerson

All rights reserved. No part of this publication may be reproduced,
distributed, or transmitted in any form or by any means, including
photocopying, recording, or other electronic or mechanical methods, without
the prior written permission of the publisher, except in the case of brief
quotations embodied in critical reviews and certain other noncommercial uses
permitted by copyright law.

Limit of Liability/Disclaimer of Warranty: While the publisher and author
have used their best efforts in preparing this book, they make no
representations or warranties with respect to the accuracy or completeness of
the contents of this book and specifically disclaim any implied warranties of
merchantability or fitness for a particular purpose. No warranty may be
created or extended by sales representatives or written sales materials. The
advice and strategies contained herein may not be suitable for your situation.
You should consult with a professional where appropriate. Neither the
publisher nor author shall be liable for any loss of profit or any other
commercial damages, including but not limited to special, incidental,
consequential, or other damages.

 

 



Contents

INTRODUCTION

BASIC COMPONENTS OF MS EXCEL

Cell

Columns

Rows

Fill Handle

Address Bar

Formula Bar

Title Bar

File Menu

Quick Access Toolbar

Ribbon

Worksheet Tab

The Status Bars

MICROSOFT EXCEL: A QUICK GUIDE

Microsoft Excel Shortcuts

History

How does Microsoft Excel Works?



Features of Excel

Graphical Features of Excel

Pictures

Shapes

Clip Arts

Smart Arts

Charts

Functional Features of Excel

Conditional Format

Functions

Hyperlinks

Spell-check

Add-ins

VBA Macros

Dataset Features of Excel

Slicers

Pivot Table

Tables

Grouping

Sorting



Filtering

Database

Data Validations

Other Microsoft Excel Features

New Data Types

Six New Features

Filtering Pivot Tables Using Timelines and Slicers

Quick Analysis Tool

Recommended Pivot Table

Office Add-ins

Detailed Record of a Cloud File

Integrated Data Model

Simple options for file sharing

Why Should You Learn Excel?

Benefits of Excel

TIPS TO USE EXCEL TO INCREASE PRODUCTIVITY

UNDERSTANDING SPREADSHEET

Using Spreadsheets

Modify the appearance of spreadsheet cell content.



Font

Style

Add various colors to the cell background and content.

Format Cell to Display Percentage, Currency Symbols, Dates and
Numbers

Number

Date

Percentage

IF Function

Make Use of Round, Counta, Count, Maximum, Minimum, Average and
Sum Functions

Spreadsheet Functions and Formulas

Formulas #REF!, #NAME? And, #DIV/0! Are Standard error values
you need to know?

Absolute and Relative Referencing Cell in Formula

Worksheet

Delete a Worksheet, or Add a Fresh Worksheet

A Spreadsheet's Worksheets can be Renamed, Moved, and Copied

Manage Worksheet

Selecting a Column or Row



Delete or Add Columns and Rows

Modify Row Height, Column Width to a Specific Value

Unfreeze, Freeze Column or Row Titles

You can "Delete", "Move" and "Copy" Cells in Spreadsheet

Cut, Copy and Paste Cells in Spreadsheet

Delete the Content of a Cell in a Spreadsheet

Arrange and Edit Cells in Spreadsheet

Make Use of "Redo" and "Undo" Command

Use "Find" Command

"Replace" Command is Used for Certain Worksheet Content

Use "Match Case" Checkbox

Cell Range can be Sorted in Descending or Ascending Alphabetical
Order or Descending or Ascending Numerical Order.

Cell in a Spreadsheet

In a cell, input a text, date, or number.

Improve Efficiency

Create A New Spreadsheet or Workbook in Microsoft Excel

Microsoft Excel Workbook

Create an Empty Workbook.

Run a Current Excel Workbook



Use a Template to Create a Workbook.

Keeping Microsoft Excel Workbook Safe

Encrypt the Whole Excel Workbook with a Password to Block
Unauthorized Individuals from Opening It

Password Encryption

Mark Workbook as Final

Secure Personal Sheets and the Workbook Layout to Prevent Removing
or Adding More Sheets

Secure Excel Workbook

Selectively Enable or Restrict Alterations to Important Cells or
Formulas in Your Excel Spreadsheets, Make Use of the Protection
Feature

How to Input Date in Microsoft Excel

Several Methods of Inputting Date in Microsoft Excel

Inputting current time and date in Excel

Excel shortcuts for inputting the current date as a timestamp.

Add the present time and date, that are regularly updated.

How to Apply Microsoft Excel's Auto-populate Dates

Automatically Populate Per Day Date Series

The Very First Cell must have the Initial Date

Excel's Pop-up Calendar Allows You to Add a Date



Delete or Edit Cell Content in Spreadsheet

Input Data into a Cell

Delete Column Content

Delete Row Content

Delete Cell Content

Edit Cell in Spreadsheet

EXCEL MAIN FUNCTIONS AND FORMULAS

Time and Date Functions

Basic Functions

VLOOKUP Function

Numeric Function

String Functions

Add Functions

Mathematical

Logical

Statistical

Time and Date

Text Functions

Common Errors to Avoid in Excel

Merge and Center Cells



Non-Tabular Layout

Format Date as Text

External Links Mistakes

Format the whole Rows or Columns

Format Data to Encode

Color Formatting in Excel

Several Records in a Single Cell

Sum Ranges with Missing Cells

Use .xls kind of file

DATA FILTERING AND SORTING IN MICROSOFT EXCEL

How to Filter Data in Excel

How to Sort Data in Excel

Pivot Tables

HOW TO USE GRAPHS AND CHARTS IN EXCEL?

Type of Excel Chart

Surface chart

Stock Chart

Bubble or Scatter Chart

Waterfall, Tunnel or Radar Chart



Doughnut or Pie charts

Line Chart

Column Chart

Bar Graph

Area Chart

How to Use Your Data to Build Graph in Excel

Graphs and Charts Best Practices

Data Charting Methods in Excel

MICROSOFT EXCEL ADVANCED FORMULAS AND FUNCTIONS

TRIM Function

OFFSET Formula

OFFSET Function Formula

LEFT, MID and RIGHT Formula

VLOOKUP Formula

CONCATENATE Formula

SUMIF Formula

IF OR Formula

IF AND Formula

MATCH Formula

INDEX Formula



VLOOKUP Formula in Excel

VLOOKUP Formula Arguments

VLOOKUP Uses

INDEX Formula in Excel

Syntax uses of INDEX Function

Basic Uses of Excel INDEX Function

MATCH Formula

Uses of MATCH Function

TROUBLESHOOTING

How to troubleshoot issues in Excel

How to Troubleshoot Formulas in Microsoft Excel

Make Use of Error Checking

Discard Basic Mistakes

Excel can Help.

Use the Auditing Tools in Excel

MICROSOFT EXCEL FREQUENTLY ASKED QUESTIONS (FAQS)

CONCLUSION

 



INTRODUCTION
 

 

Microsoft's spreadsheet application Excel is part of the Office family of
software used mostly for business purposes. Users can edit, arrange, and
analyze data in spreadsheet by using Microsoft Excel.

 

Data scientists as well as other users can organize their data using
applications such as Excel to make data easier to understand as details are
altered or added. In Excel, there are several boxes referred to as cells that are
arranged in columns and rows. These cells contain data.

 

What’s more? It is possible to use Excel with several other Office
applications because it is part of Office 365 suites and Microsoft's Office.
The spreadsheet application runs on the iOS, Android, macOS and
Windows operating systems.

 



Excel enables individuals to turn numbers into data which can be used for a
lot of purposes both personally and professionally. Excel can execute
formulas and functions in addition to simple arithmetic, and with the use of
Visual Basic Analysis (VBA), it may also be used to add custom macros. You
will go through these features in further detail, in addition to the way Excel
differs from Google spreadsheet.

 

There are several spreadsheet programs, but Excel is one which is most often
used. It has been used for over thirty years, and during this period, it has been
improved with a rising range of functions.

 

Excel can be used for various business functions, like business analytics,
document management, stock management and invoicing, accounting, and
budgeting, A few tasks it could also do for you are as follows:

Creating charts and graphs
Storing and importing of data
Editing text
Creating dashboards or templates
Task management and a lot more.

 

You should first understand the three main important Excel features, which
are:

 

Workbook

Like every other application, a workbook is a separate file.Thereis more than
one worksheet in every workbook. A workbook is also described as a single
worksheet or as a group of worksheets. Worksheets can be removed, added,



or hidden without being discarded from the workbook, and the ordering of
your worksheets can be modified.

 

Worksheet

A worksheet is made up of separate cells, and each cell may contain text, a 
value, or formula.  Additionally, it includes an invisible sketch layer that 
contains photos, charts, graphs, and diagrams. Selecting the button at the
bottom of a workbook page would then lead you to every worksheet within a
workbook. A chart worksheet usually shows a singular chart that can be
accessed via selecting a button andcan also be saved in a workbook.

 

Cell

The smallest and most significant feature of a spreadsheet is a cell. You have
the choice of inputting or copying and pasting any data into a cell. Dates,
numbers, and texts all constitute data. Also, you can change its border, size,
font color and background color, as well as other features. A cell's address,
consisting of row number and column number, serves as a distinct identifier
for every cell (If a cell is on the 13th column and row CD, the cell will be
addressed as CD13).

 

 

BASIC COMPONENTS OF MS EXCEL
 

Cell



The address bar, which is highlighted by a rectangular box, will show the
name of the currently selected cell.A cell can also be active when you click
on it or use the cursor keys on your keyboard. You can use F2 or double-click
a cell to change the active cell.

 

Columns

A column refers to a vertical cell group. A worksheet has a total of sixteen
thousand three hundred eighty-four (16384) columns in a single worksheet.
Each column has a unique identifying alphabet, which ranges from A to
XFD. Clicking on a column's header will select that column.

 

Rows

These are horizontal groups of cells. There are total rows of one million
forty-eight thousand five hundred seventy-six in one worksheet. From row
one (1) to row one million forty-eight thousand five hundred seventy-six
(1048576), each row has a unique identifier. By selecting each row number
displayed on the left side of the window, you can select a particular row.

 

Fill Handle

In the lower right-hand corner of the selected cell, there is a small dot named
the fill handle. You can input serial numbers; insert ranges, text series,
numerical figures, etc. with a fill handle.

 



Address Bar

The address of the current cell is shown in the address bar.

 

Formula Bar

Below the ribbon is an input bar called the formula bar. It displays the
contents of the currently selected cell and allows you to enter formulas into
cells.

 

Title Bar

This will display the title of your worksheet followed mostly by a phrase
"Microsoft Excel".

 
File Menu

This is a common menu that is found in every application. It includes features
such as Print, Excel Options, Share, Open, Save As, and so forth.

 

Quick Access Toolbar

Using a toolbar called the quick access toolbar, you can easily access the
functions you use the most. By adding a new command to the Quick access
toolbar, you can add your preferred commands.

 



Ribbon

Microsoft Excel 2007 introduced ribbons as a replacement for all the
command menus. Ribbon tabs are just a collection of unique selection
groups, each of which also includes a command.

 

Worksheet Tab

This tab shows all the worksheets which are present in the workbook. By
default, you will see three worksheets in your new workbook with the names
Sheet1, Sheet2, and Sheet3 respectively.

 

The Status Bars

This is a small bar found at the bottom of an Excel window. When you start
using Excel, this will offer you immediate assistance.

 



MICROSOFT EXCEL: A QUICK GUIDE
 

Microsoft Excel is a spreadsheet application being used for keeping records
and analyzing statistical data. Envision a spreadsheet as a collection of data
tables with rows and columns. Numbers are assigned to Excel rows and
alphabet to columns respectively. Cells are found at the intersection of a row
and a column. Numbers specify a row and alphabetical letters specify a
column, and together they provide the address of a cell. 

 

In a many ways, everyone works with figures. Everyone has everyday needs
that they must meet from their income. The ability to differentiate your
personal earnings versus expenses is important to spend money properly.
When we want to collect, evaluate, or save such numerical information,
Microsoft Excel becomesauseful tool.

 

In Microsoft Excel, a workbook is different from a worksheet. Worksheets
are collected in a workbook.

 

A workbook by convention has 3 sheets to meet your needs; you can add
more sheets or remove the sheets. The titles of the sheets by convention are
Sheet1, Sheet2, Sheet3, etc. The sheet labels can be edited to more specific
words, such as everyday expenditures, weekly expenses, annual budget etc.

 

A worksheet consists of columns and rows and cells are formed when a
column and a row intersect. Also, data is recorded in cells. Every cell is



represented with a cell address (rows are commonly labeled with numbers
while columns are in letters). 

 

Microsoft Excel: Where can I get it?

Microsoft Excel is accessible in several ways, such as:
Microsoft Excel can be downloaded from the Microsoft website
where the license key must be purchased first.
It can be purchased in a hardware computer store.  

 

Microsoft Excel Shortcuts

 
F2 Verify the formula and the cells represented.
SHIFT + F11 to open a fresh spreadsheet.
The function add dialog box is opened by clicking "SHIFT + F3". 
Paste data from notepad using "Control + V".
Use "Control + C" to copy the existing selection's contents.
The existing worksheet is saved with "Control + S".
A new worksheet is opened using "Control + N".
To display the print dialog box, use "Control + P".



 

History
Microsoft Excel was created by the Microsoft Corporation early nineteen
eighty-five (1985). Excel is a widely used spreadsheet application that
separates data into rows and columns which may be altered through the
application of formula, allowing the program to perform mathematical
operations on the data.

 

The Lotus Development Corporation initially launched Lotus 1-2-3 in
nineteen eighty-two (1982), so it rapidly became an accepted standard for
personal computers running Microsoft's MS-DOS computer system. The
original prototype of Excel was a competitive spreadsheet created by
Microsoft and it was made accessible in nineteen eighty-five for the
Macintosh computer made by Apple Incorporated. The new system gained
prominence immediately due to its speedy processing and stunning visuals.
Excel was able to expand in popularity among Mac users since Lotus 1-2-3
was not accessible for the platform.

 

In 1987, Microsoft introduced the next version of Excel, which was the first
to function on the company's private label Windows operating system. The
reliable software's user interface's emphasis on graphics helped it gain
popularity immediately.Excel was eventually able to overtake Lotus as the
industry standard in the middle of the 1990s because Lotus took a bit longer
than expected to release a windows version of its spreadsheet, which allowed
Excel to increase its market share.



 

With the advent of more automated functionalities, various shortcuts, 3-D
charts, sketching, outlining, and toolbars, Excel gained significant
improvements in early stages. Microsoft modified the naming convention for
Excel in 1995to highlight the original year of the product’s debut. The 32-bit
machines which used the 386 Central processing unit from Intel Corporation
were made with Excel 95 in view. Excel 97 and Excel 99 both saw the launch
of new versions of Excel 2000.

 

 

A major emerging feature which enables consumers to restore Excel data in
case of a system crash was introduced in the Office XP suite's Excel 2002,
which also was launched in 2003. Minor upgrades, like the functionality to
extract data from all other software, was included in Excel 2000 and 2003.
Excel's functionality increased to approximately a million rows and sixteen
thousand (16,000) columns when it changed to the Ribbon layout in 2007.

 

Excel 2010 made some improvements to the Ribbon user interface and pivot
tables. Some new tools included in Excel 2013 enabled users to create
intricate data models.

 

The Forecast Sheet component and the capability to display data on a 3D
landscape was introduced to the system's revamped version in 2016. Various
new functions such as keyboard shortcuts, doing calculations, funnel charts,
map charts, as well as other additional features were all included in the
upgrade that occurred in 2019. As a result, since its formal launch, Excel has



evolved from a basic simple spreadsheet application to a multifaceted
program with a wide range of useful functions.

 

How does Microsoft Excel Works?
Spreadsheets are used to track, organize, and store data sets using functions
and formulas in Excel, a versatile data visualization and reporting program.
In addition to many other professions, Microsoft Excel is utilized by data
analysts, data scientists, accountants, and marketers.

 

The Microsoft Office software family includes Excel.Excel provides effective
tools for analyzing and reporting numerical data that has different uses in a
wide range of industries. Calculations are the program's most basic and
noticeable use. Excel allows you to create alternative options, analyze how
they operate using different components, and obtain the numerical results of
complex calculations.

 

With the use of histogram, bar graphs, charts and graphs, this software also
allows you to represent analytical models and data graphically. Excel is an
effective statistical tool since it has features like multivariate analysis, linear
and polynomial fits, standard deviation, mean and error range in graphs, etc.
Thus, this application is far more than a table with just an advanced installed
calculator.

 

In a business setting where complex calculations and budgeting are extremely
necessary, Excel has also found usage. For instance, this application is indeed



the appropriate software for setting and maintaining track of user databases
that can be used for brand awareness.

 

Excel can also be utilized to organize events as well as other commercial
transactions by creating a table with the activities that need to be done and
the personnel who will execute them. Due to a variety of effective features
with automated computations, this application also serves as an effective tool
for maintaining a budget, because doing so saves a lot of time and reduces the
chance of making mistakes. Excel is an essential tool in several fields due to
its broad range of applications.

 

Features of Excel
Microsoft Excel includes a wide range of features, including graphical,
functional, dataset, and other features.

 

Graphical Features of Excel

Various graphical tools can be used in Excel to display data as images and
graphs. The following are examples of graphical features of Excel:

 

Pictures

Users can add any picture to the files to enhance their data; Backgrounds of
worksheets, charts, and shapes are a few examples.

 



Shapes

To exhibit the data in shapes and info graphics, a variety of shapes are
available. With the help of the free form characteristics, you may make any
shape.

 

Clip Arts

To present a visual message, we can add readily available clip arts.

 

Smart Arts

You can also use Smart Arts to graphically connect data in different ways to
display information.

 

Charts

Charts are really a great way to present data in a comprehensive graphical
style.

 
Functional Features of Excel

Users can execute difficult computations with the use of Excel features and
tools that also improve Excel's functionalities.The following are examples of
functional features of Excel:

 



Conditional Format

Data can also be formatted in accordance with certain criteria using
conditional formatting. This enables you to view the important data range.For
data analysis and ETL, Excel has a large collection of add-ins.

 

Functions

There are over three hundred (300) installed formulas in Excel Cells, which
includes formulas for String, Math, Date, Text, and more, that can be used to
carry out variety of calculations.

 

Hyperlinks

To efficiently navigate in between various sections of the dataset in Excel,
use hyperlinks.

 

Spell-check

The installed spell check function can be used to prevent spelling and
grammatical mistakes in the dataset.

 

Add-ins

To increase the function of a spreadsheet, you can create .NET or Visual
Basic Application (VBA) add-ins for Excel.

 



VBA Macros

Excel has Visual Basic Application programming that is used in VBA
macros. You may automate repetitive work by using macro features.

 

Dataset Features of Excel

You can create datasets and execute a range of data processing tasks with
Excel. The following are examples of dataset features of Excel:

 

Slicers

This enables you to connect several pivot tables and analyze information with
buttons; this was introduced in Excel 2010.

 

Pivot Table

To efficiently create cross tables with summary data, use pivot tables.

 

Tables

You can arrange rows and columns using child and parent records. As a
result, it will be simple to launch a short investigation.

 

Grouping



The columns and rows can be grouped through child and parent entries.

 

Sorting

Data can be sorted in Microsoft Excel. Data can be arranged using a column
or more in either descending or ascending order.

 

Filtering

Excel allows you to filter data.  A variety of choices can be set to filter only
the most important options. Microsoft Excel has a function called Advanced
Filtering that enables you to execute more complicated filters.

 

Database

Excel can be used as a database to upload a million records. Youcan load data
into Excel via connecting to various databases.

 

 

Data Validations

You can maximize the kinds of information which can be entered into a cell
using the data validation feature. In addition, you can display a drop option
which you can select from a specified set of choices.

 



Other Microsoft Excel Features

Other features of Microsoft Excel includes:

 

New Data Types 

Geography and Stock are the two new kinds of data that was introduced in
Excel 2019, which can be used to connect online data to your spreadsheets.
To improve analysis and reports, you can add specific business-related data
into your spreadsheets. In your spreadsheets, you can connect demographic
as well as other data about states and cities by using geography kinds of data.

 

Most business professionals now include data in business spreadsheets;
however, they do not want to spend time searching for it or entering it
manually. Geography and Stock data types provide easy and quick access to
this data. These two major data types improve Excel's accuracy and
effectiveness as a result.

 

Six New Features

The six new features that were introduced to Excel 2019 were well-liked by
many users.Here are the six brand-new features in Excel 2019: SWITCH,
IFS, TEXTJOIN, MINIFS, MAXIFS, and CONCAT.

 

Filtering Pivot Tables Using Timelines and Slicers



Now with assistance of a screen graphical object called slicers, you can
quickly filter data in several columns in your pivot tables. The date type in
the Data Model can serve as a filter for pivot table data graphically using a
timeline.

 

Quick Analysis Tool

The Quick Analysis tool for worksheets is accessible in the bottom corner of
every selected table. With this tool, it is feasible to add values to columns or
rows, create a pivot table or chart, and use conditional formatting for data in
the chosen table.

 

Recommended Pivot Table

Microsoft Excel users now create pivot tables, when it involves creating them
for data sets uploaded into data tables and data lists imported from separate
database management systems. Simply place the cell pointer in a cell of the
data list and choose “Insert” and select “Recommended PivotTables” from
the Ribbon. The Recommended Pivot Tables will then open, showing a list of
several pivot tables that you can create on a new worksheet in the existing
Excel workbook by selecting the “OK” button.

 

Office Add-ins

By using Office Add-ins, users can extend function by installing a selection
of customized mini programs also known as applications that are accessible



from the Office Store directly from inside the application.

 

Detailed Record of a Cloud File

It is straightforward to save and update your preferred spreadsheets on your
Firm's SharePoint website or OneDrive using the Excel Save and Open
screens. Excel's AutoSave Feature saves all your edit updates to the
workbook files as you operate when you manually save a workbook file to
the cloud. By selecting the newly added Model History button which is
located close to the Share button on that same row also with Ribbon tabs, you
can view all previously created versions of the document and copy or restore
them.

If you store your workbooks in any of these cloud-based storage services, you
can view them through any device that runs Excel and from anywhere.

 

Additionally, youcan also review and update your workbooks via Excel
online, which is easily accessible using basically all major web browsers,
when you do not have access to a PC to run Excel.

 

Integrated Data Model

When you import datasets from separate database management programs and
create data sets in Excel, you can create one-to-one and one-to-many
connections. Data generated from any of these columns can be included in
the Excel charts and pivot tables that you generate due to the links between
the data lists and tables in the data model.



 

Simple options for file sharing

Using Excel to share data and co-author worksheets with coworkers has
never been easier or possibly more successful.It is easier for you to share by
using Excel online because a Share button is available, and it is located at the
top right of the rows with Ribbon bars in the worksheet view. You can present
workbooks which are saved on your OneDrive in the cloud via Skype
meetings and publish them to social internet sites in addition to inviting
others to view and edit them.

 

 

Why Should You Learn Excel?
Excel is a versatile spreadsheet and data analytical tool that includes
numerous features. A fast and effective method of learning Excel will be to
take an online Excel course. Although there are four major advantages of
learning Excel for your job, as well as reasons you should learn Excel.

 

Your worth in the employment market increases when you learn Microsoft
Excel. Since Excel is used in various ways, employers always place a high
priority on this skill. Taking Excel classes will teach you more advanced tools
for using the software that will make you stand out in the employment
market.

 

Microsoft Excel is used in many different situations, such as:



Making plans for employees.
Budget management.
Keeping records of expenses and income.
Taking note of inventories.
To present data, create dashboards, info graphics, and charts.
Microsoft Excel training increases your productivity.

 

Your ability to finish a range of projects and jobs efficiently will improve as
your Excel skills improve. For instance: Data can be easy to understand
through adding a template to a group of cells or a cell depending on
predetermined criteria using conditional formatting. You can track and
manage trends in a large dataset and use the information to guide business
strategies by using charts and pivot tables.

 

Proficient Excel skills are vital for several roles in the finance sector. In
addition to the financial management system, accountants will need Excel.
Excel is commonly the primary tool used mostly by financial analysts when
executing financial modeling. Business analysts can use Excel's analytical
and reporting tools to enable them to make more effective business decisions.

 

Excel skills are also useful for contingent workers. Journalists usually handle
a lot of data, and Excel can help them do it effectively. Excel is a tool that
marketers can use to manage clients at different points in the purchase
process. Excel can also be used by freelancers to keep track of their work,
money, and time.

 



To be relevant in today's business environment, every business must expand
and advance. Offering development initiatives that allow employees to keep
abreast with the latest technologies and do respective jobs as effectively as
possible is one option to differentiate yourself from your competitors and
boost profitability. Employers can protect their employees, one of their most
significant assets, by investing in ongoing promotion and training.

 

Skilled employees work to maintain their position in the organization and
seek challenges. Employers can boost employee continuity by offering them
the continuing training they need to be as efficient as they desire, minimizing
turnover of employees as well as the risk of losing the best staff to competing
companies. These training and learning programs frequently include Excel
for Businesses as a part of their modules.

 

Most jobs within an organization can benefit from and utilize a few key
abilities that are the subject of advanced Excel learning. When you stick to a
course, you will become more skilled at using Excel. The advantages of
receiving Excel training include the following:

 
Assess, manipulate, and visualize data.
Write formulas which will enable you to present additional details
on crucial business operations, such as inventory levels and
utilization, budgets, financial estimates, project efficiency and
workflow.
Create a data set that is easy to understand so that management
staff can easily examine current initiatives or conditions in the
organization.



Create spreadsheets with integrated data structure and
visualization of the inputted information.
Study and comprehend spreadsheets and data from various
customers, suppliers, and organizations.
Through being able to analyze data at a more complex level, one
can provide solutions to issues that affect the organization.
Complex economic and inventory accounting must be balanced,
organized, and maintained.
Design tracking software for various tasks and departments, with
consideration for diverse workflow processes.
Advanced Excel training will not just give companies more
professionally skilled employees, it will also give employees the
skills they must function better in their current jobs and prepare
them for promotional offers to senior positions.

 

 

Whenever you are dealing with huge amounts of information and
calculations, Excel is a vital tool for boosting productivity and enables
employees to be more effective. Your ability to make use of Microsoft Excel's
most complex capabilities comes by a better understanding of the application
that allows you to finish jobs and execute data analysis more effectively.
Additionally, you will be able to keep your team members abreast of new
information that will speed up the workflow process.

 

The skill to optimize your calculations will be much stronger when you have
extensive Excel knowledge. Calculations that need to be repeated regularly
take a lot of time, particularly if accuracy is needed. Users can make
calculations that are more difficult by using Excel's more sophisticated tools.
Whenever a formula is created and each defined function has been written,
the software will execute each of your calculations, allowing you to work on



some other projects and ensuring that such data you receive is correct the
very first time.

 

Benefits of Excel
 

Microsoft Excel has a lot of benefit, and these benefit is as follows;

 

Microsoft Excel is Available via Mobile Apps and Online

Even though Microsoft Excel provides a web edition and many organizations
are switching to the cloud nowadays. It contains a huge number of
functionalities, including functions such as, pivot charts, and pivot tables, like
the desktop version.

 

Data Can Be Stored with Hundreds of Rows

Excel has a limitation on the number of columns and rows, but data
isnotlimited. Due to this, Microsoft introduced Power Pivoting, a tool which
enables you to save data in a spreadsheet with millions of rows and then do
calculations in it.

 

Clean and Analyze Data

If you often deal with data, you will experience various circumstances which
will require you to manage dirty data that needs to be cleaned before use. It is



time-consuming and requires a large amount of effort to transform and clean
data. Microsoft created the power query, which is a data transforming and
cleaning engine, for addressing this issue. With power query, you can import
data from various sources, transform, and transfer it back into the
spreadsheet.

 

You Can Automate with Coding

Microsoft Office includes its own programming language known as Visual
Basic for Applications (VBA), which enables you to manually create code
foryourregular task in Excel. Using a VBA code, you can automate every
task, from basic (bold text) to the advanced (create pivot table).

 

A Variety of Freely Available Templates

The ability to create templates and dashboards in Microsoft Excel is just one
of its best-known features. You can use a variety of free layouts which are
available to be downloaded. Excel Templates for Free to get started includes
Expense Tracker, Sales Template, and Inventory Template that includes
Formulas.

 

 

Printing of Report is Easy with Excel

However, if you love preserving trees, there may be a point when you will
have to print reports either to present to someone or share with others. You
can alter the orientation, paper size, margin, and other printing settings in



Excel. Whenever you want to print a report, there are a ton of options you can
utilize for page setup.

 

Using Charts to Create Data Visualizations is Simple

You can represent your analytical results by using Excel's various charting
tools. With only one click, you may enter each of the important types of
charts you need for your data presentation.You can view all charts that are
available by navigating to the “Insert” tab and choosing the preferred chart.

 

Furthermore, there is an option named "recommended charts" which you can
apply, and Excel will recommend the ideal chart to apply for your data
visualization.

 

Additionally, you have the choice to make complex charts by using various
techniques and methods when you feel that you need anything different from
the standard charts. You can also design in-cell charts to keep your data
simple for anybody to understand.

 

Excel Has All Data Analysis Tools.

Excel’s major aim is to interpret data and draw inferences from the data. The
good thing is that Excel possesses a few of the most effective tools that are
available for data analysis. Assuming you have data comprising hundreds of
rows; you could use a pivot table to make a summary table from that data.

 



By creating pivot table, users can carry out the following kinds of data
analysis: 

Running overall column
Addition of date timeline
Column ranking
Conditional formatting
Date grouping in a pivot table.

 

You can Calculate with Excel

Excel's ability to calculate is what differentiates it from other spreadsheet
programs. You can perform all your calculations by using a wide range of
functions in Excel. An Excel function is mainly a pre-written equation which,
when used with the data you entered, it generates a particular result. In
addition, you can make your personal formulas by merging two or more
functions together or merely by doing math with operators.

 

Best Method for Storing Data

Even if you have never used the tools or options it offers, Microsoft Excel is
the most effective way to save data.

 

 



TIPS TO USE EXCEL TO INCREASE
PRODUCTIVITY

 

Excel is used by many companies globally to complete a wide range of tasks.
Excel may be used for anything from basic analysis of data to complex
activities such as creating notes, recording sales, managing inventories and
more. It offers a grid interface which enables users to arrange and manage
various kinds of data according to their preferences for structure and design.

 

Microsoft Excel has a lot of tips and features that you can use to improve
your productivity, although most users think that it is merely an application
for numbers. Ways to use Microsoft Excel to increase your productivity
includes:

 

Using the Keyboard Shortcuts for Excel

If you are not familiar with the appropriate keyboard keys, switching between
Excel documents and sheets might be a problem. For instance, click "Ctrl +
F1" to hide the ribbon whenever you need a lot of space.

 

UsingQuick Average, Minimum, Maximum and Sum

Using "Command + Shift + T" on a MacBook or "Ctrl + Shift + T" on a
Windows computer will quickly calculate a sum of inputted numbers.You
will notice a dropdown on the sum in the filtered Excel table. To view other



options, like maximum, minimum, average, count, standard deviation, etc.,
click on the dropdown.

 

Using Freeze Header

When dealing with wide and lengthy spreadsheets, it is challenging to
remember every column's header. You can just choose the second line from
the header then choose "Freeze Panes" from the "View" menu. The initial
header row would be frozen as a response to the content scrolling. This will
allow you to quickly check the header whenever you scroll the sheet. The
very first column of the spreadsheet can be frozen like the initial row.

 

Simple Formatting

Large amounts of data input in Excel can be error-prone and time-consuming.
Data entry mistakes can be expensive; however, you can reduce the work and
errors with just a few simple techniques.

 

Formatting your cells for a particular dataset is the basic process of 
controlling errors.  Increase the formatting "Number" selections from the 
"Home" page after selecting the cell or cells in question. Select the kind of 
data you would like to include in the cells. Choose the category; click on
format just on the right side, after that click “Ok” also on the "Number" tab.

 

Creating Attractive Excel Presentations from Simple Data



Your Spreadsheet contains a basic data table. With just a filter and various
row colors, you can change the plain tables into a beautiful Excel table. You
can click the inside of your table and use "Control + F1" on your keyboard to
change it into a lovely Excel table.

 

Adding Cell Titles in Excel for Easy Reference

The title of any selected cell or table is displayed in the Excel "Name box"
which is directly above any cells on the left. By standard, the application
names every cell by adding the row number and column letter.

 

To avoid issues as well as increase speed when navigating to a certain range
of cells; you can give the cells, a table, or range a custom name.

Choose the range or cell and right-click to select it. 
From the menu selection, choose "Define name".
Input the cell name then choose scope. 
In the "Comment" text area, you can input any comment to define
the cell before selecting "Ok".

 

Make Use of Excel Charts

A chart is very useful for compressing large amounts of information into
simple representations which are simple to analyze and comprehend. You can
create quick informative reports by learning how to use Microsoft Excel
chart. Take the following actions:

 
Open an Excel application, click the "Insert" menu and select
"Recommended Charts".



Excel will display the different types of recommended charts that
you can use for your data.
Preview the recommended charts, select the chart you want and
simply click "OK".

 

Using Microsoft Excel Templates

It requires a lot of effort and time to create the layout of your data. Excel
provides a range of pre-made templates for numerous jobs, so you do not
need to start from scratch.

 

How to Use Excel Template?
Open an Excel application, click the "File" tab on the application
screen and choose "New".
Excel will display a list of template which can be used for a
variety of purposes, such as calendars, project management,
planning, budgeting, and much more.
Choose the template you want, and then select the "Create" button
that pops-up.

 

The template can be changed to meet your specific requirements.

 

Note: Templates can also be gotten online when you are linked to the internet.

 

In conclusion, every company and business wants to increase their efficiency
and productivity, and Excel helps with achieving that.For anyone utilizing
Excel to do various tasks, the aforementioned tips and techniques to increase



productivity will help you handle data more accurately and quickly while also
saving you time and money.

 



UNDERSTANDING SPREADSHEET

 

Using Spreadsheets
A new spreadsheet would be created after the software has already been
opened. Navigate to the menu bar and choose "File" to open a fresh
spreadsheet. Select "New" in the drop toolbar, then "Spreadsheet" in the
cascading menu that will appear. This opens a fresh spreadsheet, and it is
displayed in a default template. You can click the white cross symbol which
has a red background at the upper right-corner of a spreadsheet page to cancel
it. Spreadsheet should be saved after inputting data.

 

Follow these steps on how you can save your spreadsheet:
Select "File" from the menu bar in the application screen.
Select "Save As" from the drop menu.
A dialog box will pop-up, navigate to the folder that you want
your spreadsheet to be saved, choose the right location.
Input a new name from the "File Name" area if you wish to
change the name of the spreadsheet.
Select "Save" after changing the name of the spreadsheet.

 



The spreadsheet can also be saved in various file types, such as version
number, application file extension, text file, template etc. Calcenables you to
view several spreadsheets together. Select the "Calc" button on your device's
toolbar to change in between spreadsheets in this situation.

 

Every time Calc is operated on your device, a certain icon will always be
displayed. When this button is selected, the titles of all open spreadsheets are
displayed as previously demonstrated. The spreadsheet you would like to
view will be displayed when you click on the name. This approach enables
you to navigate between several spreadsheets.

 
Modify the appearance of spreadsheet cell content.

The "Size" and "Font" drop menu are found on the "Font" section of the same
"Format Cells" popup menu. The various font sizes and font kinds are
accessible under the "Size" menu and "Font" drop menu, respectively.
Choose "OK" after choosing the changes needed.

 

Font

Click the "Format Cells" pop up to format cell content. This pop up has a
"Style" drop menu underneath the "Font" section. You can select one of these
fonts from a variety of options, such as italic or bold.

 

Style

In the dialog popup, under the "Font Effects" section, there is a drop menu
named "Underlining" which allows you to select whether the data should be



underlined once or twice. From this menu, select the preferred underlining
style and click on "OK".

 

Add various colors to the cell background and content.

Open the "Format Cells" menu and add various colors to the cell content.
'Font Color' drop menu is found underneath the 'Font Effects' section. Select
"OK" after choosing the preferred color from the menu. To add color to the
cell background, choose the cells that you need to copy the format to transfer
it from cell range or a cell to another. Next, right click anywhere within the
range of cells and choose "Copy" from the option that displays. Enter the cell
you need to replicate the formatting. Right click the cell, and then choose
"Paste Special" from the drop-down menu.

 
Format Cell to Display Percentage, Currency Symbols, Dates and
Numbers

Number

Right click on a cell and choose "Format Cells" from the drop-down menu
that appears to format the selected cell so that it shows values to a given
number of decimal points. In the dialog's 'Options' section, underneath the
'Numbers' category and the 'Number' section, there is a setting called
'Decimal places' that allows you to select the number of decimal points that a
number should have.

 

Date 



Date is displayed underneath "Category" in the "Numbers" section within the
same "Format Cells" popup that was previously noted. Several date format
variations are provided under the "Format". The "Currency" option can be
accessible in the same popup box's "Numbers" section. You can choose one
of the numerous currency types underneath "Format" and then select "OK"
depending on your preferences.

 

Percentage

Click the same "Format cells" popup that you have previously used to display
numbers as percentages. There is a “Percent" section in the dialog box's
"Numbers" section and in the category "Format", you have a variety of
choices for formatting a number to be shown as a percentage. From this
menu, choose the right option, and then click "OK".

 
IF Function

Use the comparison operators =, >, and < to compare a value from two
specified values by using the logical function "IF". Select the cell you want to
use the "IF" function, input "=IF (", add condition followed with a comma ','
add a value if the condition is FALSE and another value if the condition is
TRUE, separate the values with a comma, close the bracket and click
"ENTER".

 

“Value_if_false”, “Value_if_true”, and “Logical_test”, are the three
parameters that the 'IF' operator uses. The conditions which also must be
evaluated to know if it is true or false is called “Logical_Test”. If the



conditions are true, the result “Value_if_true” will be shown in the specified
cell, and if the condition is not met, the value “Value_If_false” would be
shown.

 
Make Use of Round, Counta, Count, Maximum, Minimum,
Average and Sum Functions

Rounding a figure to a desired accuracy is achievable by using the
“ROUND” tool from the “Mathematical” section. There are two inputs
“count” and “number” that the “ROUND” operator accepts. Thus, the figure
that must be rounded is indicated by the prefix “number”, and the number of
places that must be added is indicated by the prefix “count”. For example, if
the “number” chosen from one cell is 5223.667 and the “count” are 3. The
“Round” function operates in this way.

 

The "COUNTA" method within the "Statistical" group calculates the number
of times values are found in the argument list. The parameter list's elements,
whether they consist of texts, numbers, as well as other values, are counted
with this function.

 

A "COUNT" function from the "Statistical" class helps to count the number
of numbers in the argument list. All value categories, such as text, are ignored
by the "COUNT" function, which only counts the number of numbers in the
parameter list.

 

Use the function 'MAX' and 'MIN' from the 'Statistical' category in the
Spreadsheet respectively, to return the maximum and minimum values from



every array of inputs.

 

Choose the cell that you tend to show the added result before applying the
"SUM" feature. In the drop menu that appears, choose "Function" after
choosing "Insert" from the menu bar. Simply choose "SUM" below
"Function" within "Function Wizard" after selecting "Mathematical" below
"Category" and select "Next". 

 

An "AVERAGE" formula uses the calculated mean of numbers found in the
specified cells. "AVERAGE" function is the same methods as used for the
"SUM" feature should be applied. Its only difference is the fact that the
'Statistical' class will be used for the “AVERAGE” function.
Spreadsheet Functions and Formulas

To calculate the correct value, formulas make use of variables and numbers.
All cell references for cells in which you must obtain the data needed for the
calculations are stored in these variables. A factor must always be considered
while creating a formula in a Spreadsheet. It is ideal to refrain from using
numbers directly in Worksheet and use cell referencing instead.

 

Updating the formulas less often when variable must be modified is now
made easier. This also saves effort and time. Use the four kinds of arithmetic
operations such as division, multiplication, subtraction and addition, and cell
referencing to create formulas in a Spreadsheet. All Spreadsheet formulas
must start with equals to "=" sign. You have the choice of inputting the 
formulas directly into the cell or by using the wizard function. For example, 
values specified in cells "E13" and "E15" are provided by the formula 



"=E13+E15".  Thus, "E13" and "E15" represent the two cells, and the 
arithmetic operation is "+". 

Formulas #REF!, #NAME? And, #DIV/0! Are Standard error values
you need to know?

#REF! : Implies that the referred cell's related sheet, row or column is
missing. This indicates that such an error number will be shown if you use a
deleted worksheet as a reference in a function or formula.

 

#DIV/0! : Means division by 0. Although division by 0 is such an
inappropriate mathematical function, which means that even if you write a
formula of the form "=E7/E8" if E8 has 0 in this instance, the wrong value
will also be displayed.

 

#Name?This code indicates the lack of a suitable reference for an input. This
implies that the error value will be shown if you pass the operator an
incorrect argument, for example 'e' in place of 'E7' or a similar error.

 

Absolute and Relative Referencing Cell in Formula

When using formulas in Spreadsheet, make sure you understand how to use
absolute cell reference and relative cell reference. Absolute references do not
modify regardless of the formula; the very same reference is replicated
whenever the formula is being pasted into a different cell. For instance, if a
formula is written as "=e10+$e$12" to do this. Whenever the formula is
repeated, the "e12" referencing will not change while the "e10" referencing
will change. 



 

Whenever you reference two cells or many cells by using a formula, relative
cell referencing prevents the duplicated formula from referring to the same
cells in a new position. Based on the initial referencing, it relates to the new
cells which have the same relative position to the formula as the old cells.

 

Worksheet
Choose the preferred worksheet title from the list that appeared at the bottom
of the Spreadsheet screen to create a new worksheet and navigate between
the various running worksheets. You can navigate between different open
worksheets in this manner.

 
Delete a Worksheet, or Add a Fresh Worksheet

You can add a new worksheet with ease by selecting the "Add Sheet" option
in Spreadsheet. By including a specified name, this option only creates a
fresh worksheet. Double clicking on the worksheet title once it has been
created with the default name will keep bringing up the 'Rename Sheet'
menu. Select "OK" after inputting the worksheet's new title in the popup. The
worksheet title will be modified. Right-click on the worksheet title to open a
drop-down menu; choose "Delete Sheet" to remove the selected worksheet.

 
A Spreadsheet's Worksheets can be Renamed, Moved, and
Copied

Moving a Worksheet to another location within a Spreadsheet, simply tap the
worksheet tab and drag it to another new location before you release the



mouse button. Tap and hold the "Control" key whilst still clicking the sheet
menu bar and drag it to your preferred location in the same Excel
spreadsheet, then release the mouse cursor to copy the worksheet. You can
rename a spreadsheet by double clicking on the worksheet title to display the
"Rename Sheet" box. Select "OK" after typing the worksheet's new title in
the dropdown menu. The worksheet title will be updated.

 
Manage Worksheet

There are several ways you can manage your workbooks, and this includes:

 

Selecting a Column or Row

When you want to choose a column or a row, just click on the selected
column or row tab once, and the whole column or row will be selected. 

 

Delete or Add Columns and Rows

To add a column or row, right-click on the row header above where you
would like to add the row or the column header towards the left of where you
would like to add the column. Select "Insert Columns Left" for columns from
the ensuing submenu, and "Insert Rows Above" for rows. It will add a fresh
row or column to the worksheet. Right click on the column or row header that
you want to delete or choose several rows or columns and right click on any
headers from the wide ranges, to erase the chosen column or row. 

 

Modify Row Height, Column Width to a Specific Value



Right-click on the column header and select "Column Width" from the
shortcut menu, or right-click on the row header and select "Row Height"
from the shortcut menu, as needed, to modify the row heights or column
widths. The "Row Height" or "Column Width" pop-up box will be shown,
which allows you to change the height or width of the row or column. Select
"OK" when you have inputted the right value. 

 

Unfreeze, Freeze Column or Row Titles

Tap on the row header under the column or row you would like to freeze or
click on the column header towards the right side of the column you would
want to freeze. Thereafter, choose "Window" from the menu bar. Select
"Freeze" in the ensuing drop menu. According to your preferences, this will
freeze the columns and rows. By choosing "Freeze" again from the drop
menu beside "Window" on the menu bar, you can unfreeze both columns and
rows.

 
You can "Delete", "Move" and "Copy" Cells in Spreadsheet

Choose a range of cells or cells you would like to copy the contents to
another worksheet, between worksheet, or within a worksheet. Next, right
click any part of the selected area, and on the menu that displays choose
"Copy". Proceed to the location of the cell where you want to copy the
specified cell range or cell. This location could be within a separate
worksheet from the same spreadsheet, the present worksheet, or the other
opened spreadsheet. Right click the cell and select "Paste" from the displayed
option. This means that the information will be copied between two different
locations.



 

Cut, Copy and Paste Cells in Spreadsheet

Make use of the "Fill" option to copy the data by selecting and dragging the
cursor to the preferred cell or cells. Then, choose "Edit" from the menu bar.
Choose "Fill" from the drop menu that displays. Choose "Right," "Down,"
Up," or "Left," from the cascading menu based on the cells you already
specified. It will also duplicate the specified cell's data to all the remaining
cells.

 

Choose the cell which you would want to begin the series with, also while
continuing to hold the mouse cursor, choose the cell in which the series must
be formed, to add data gradually. Then, choose "Edit" from the menu bar.
Choose "Fill" from the drop menu that is displayed and choose "Series" from
the cascading menu. A "Fill Series" text box will be displayed, input the
entries, and choose the "Direction" and the "Series Type" then choose "OK".
Your series will be pasted in the chosen cells.

 

Delete the Content of a Cell in a Spreadsheet

Right-click on the cell you want to delete and select "Delete Contents" from
the menu that is displayed and select "Ok".

 

Arrange and Edit Cells in Spreadsheet

When you double-click on a cell, it will enable you to change or amend the
contents. Use the backspace key on your keyboard to discard any previous



information from that cell, then input the new data as needed. This shows
how a cell's contents can be amended or changed in Spreadsheet. 

 

Make Use of "Redo" and "Undo" Command

The "undo" command is used to restore the results of any most current
modifications made to the file, beginning with the most current ones. The
report's latest change is made again when the "redo" command is used.
Navigate to the menu and select "Edit" to view the undo and redo commands.
Select "Undo" or "Redo" from the next drop menu, based on whether you
would like to use the "undo" or "redo" command.

 

Use "Find" Command

You can also use the search option by selecting "Edit" which is found in the
menu bar, select "Find" from the drop options.      

 

"Replace" Command is Used for Certain Worksheet Content

Navigate to the menu and choose "Edit" to use the replace option for a
particular piece of information in a worksheet. Next, from the ensuing drop
menu, choose "Find and Replace." With this, the "Find and Replace" popup
will be shown. Input the text that should be replaced within that "Search For"
section and the phrase that should replace it in the "Replace With" section of
this dialog. Then, select "Replace" to edit the text of the cells one at a time or
"Replace All" to edit the contents of every cell at once.

 

Use "Match Case" Checkbox



This command will enable you to search for data in cells that the information
did not only match the provided information that is inputted in the "Search
For" which is in the same case too. "Other Options" can be used to display
the expanding options.

 

Cell Range can be Sorted in Descending or Ascending
Alphabetical Order or Descending or Ascending NumericalOrder.

For numeric descending and ascending of numeric order in a cell, choose the
cell range first, then select "Data" from the menu tab. Select "Sort" from the
displayed option. The "Sort Range" box will be open initially and required if
other cells are included or the specified cells only, choose "Current Selection"
to sort the cells.

 

Cell in a Spreadsheet

There should not be more than a piece of information in each cell of a
spreadsheet. If you need to input a person's name, the first name, middle
name (if available), and last name, must all be typed in separate cells. This
makes it easier and efficient to edit and analyze data.

 

The best practices for creating lists should be recognized: make sure the cells
surrounding your list are blank, before a Total row leaves a blank row to
separate it from the other rows, avoid having blank columns or rows in the
main section list.

 



Most vital point is to organize your information so that it will be recognized
as a list once it appears in a Calc spreadsheet as a table. Whenever you
manipulate information in Calc, you only have to choose a cell from the
listing, and all the tools will automatically choose your list according to a set
of algorithms. Every blank column or row is considered as the list boundary.
Which is why it is essential that a list never contains any blank columns or
rows. Specific lists must also be separated by a border of blank columns or
rows.

 

In a cell, input a text, date, or number.

Double-click the cell you would like to input a number, and then enter it by
using your keyboard. Numerals are by convention positioned to the
right.Choose a cell and input the dates in required form after following the
instructions. The date component is separated with a hyphen (-) or slash (/).
The date style would automatically change to the one that was chosen for
Calc. Double-click a cell, and then input the text you want when you want to
add text. The text elements are by convention aligned left.

 

Improve Efficiency

Use the Zoom option by selecting the minus (-) or plus (+) symbol from the
zoom slider just on the status bar will alter the display magnification. Select
the percent figure from the status bar for more customized modifications. The
"Zoom and View Layout" menu will appear. By choosing the preferred values
from this window, the proper changes can also be done.

 



Integrated toolbars can be hidden or displayed. The ribbon can be minimized
and restored. By using the 'View' option on the menu bar, you can choose if
the other toolbars in Calc are hidden or shown. Choose the "View" and
"Toolbars" from the down menu. A range of several toolbars will be
displayed, and they can be unchecked or checked to hide or display them,
respectively.

 



Create A New Spreadsheet or Workbook in
Microsoft Excel

Excel Workbooks File Kinds are Non-Native and Native Processes
Worksheet in MS Excel Modify the Worksheet Page Data search and
Replacing using Color Search Extra. MS Excel is a software application
which is used to produce spreadsheets and makes up a part of the Microsoft
Office suite. Furthermore, the field of corporate statistics has greatly
benefited from the usage of spreadsheets in Excel.

 
Microsoft Excel Workbook

Data can be inputted and saved in Microsoft Excel workbook; a file
accessible within the Microsoft Excel software. Worksheets are spread across
a workbook. Every worksheet comprises a set of cells which can be changed
to suit the user's needs and includes data that pertains to a specific subject.

 

Data created in a worksheet is described by a workbook. Furthermore,
spreadsheets serve as the only devices used for manipulating data. Every
workbook in MS Excel has its own distinct tab whenever the title of the
workbook is shown in the title bar, operating on two systems or one
workbook simultaneously gets simpler. Whenever you start a fresh project,
you can commonly create a fresh workbook. Microsoft Excel has different
approaches to creating a workbook; these include Create an empty
Workbook, run a current Excel workbook, and use a template to create a
workbook.

 



Create an Empty Workbook.

Excel users have the choice of creating a fresh worksheet from a blank one. A
fresh workbook may also be made based on a current one. Three worksheets
have been included by standard in a brand-new workbook. The number of
files in a workbook is sometimes altered, therefore, to meet specific needs.

 

Run a Current Excel Workbook

A current workbook refers to one that has already been uploaded and saved to
an online or computer. Current workbooks saved on online data storage
platforms, SkyDrive, local PC drives, as well as other data backup sites can
all be accessed. Anybody can login or sign up on SkyDrive (which is a
Microsoft application that provides online data storage).

 

Use a Template to Create a Workbook.

Worksheet that is already created but can still be changed to satisfy users'
demands is called a template. Customized formatting and preset formulas are
part of the Excel template. When creating a fresh project, this helps to save
energy and time. You must choose the best template in line with your
requirements to create a workbook from one. Apart from Microsoft, there are
various other users and standalone service providers who can create custom
templates.
Keeping Microsoft Excel Workbook Safe

It is necessary to secure the data you are publishing whenever you send your 
Excel attached document. Your information might be something you would 



like to share, but it does not guarantee that another person should edit the 
data. Spreadsheets usually have important files that the receiver should not 
remove or alter anything from the data.  

 

All spreadsheets can be secured by using Excel's installed functionalities. I
will provide a few tips in this section regarding how to keep the integrity of
data of your worksheets in Excel. The following are the three primary
strategies you will know in this segment:

 
Encrypt the whole Excel workbook with a password to block
unauthorized individuals from opening it.
Secure personal sheets and the workbook layout to prevent
removing or adding more sheets.
 Selectively enable or restrict alterations to important cells or
formulas in your Excel spreadsheets, make use of the protection
feature.

 

Encrypt the Whole Excel Workbook with a Password to Block
Unauthorized Individuals from Opening It

By adding a passcode to a whole Excel workbook to keep others from
accessing it. When using Excel, click the Information tab from the File tab.
To encrypt your workbook to use a password, select the Protect Workbook
option. Note that passwords are usually case sensitive like the case with every
password, and make sure you use a secure and strong blend of characters,
numbers, and letters.

 

Password Encryption



To secure a workbook by using a password, click on "File", navigate to the
"Info tab" and select "Protect Workbook", and from the options click on
"Encrypt". For the sake of security for your workbook, use strong passwords,
and save it somewhere safe. You have the possibility of losing accessibility to
your important workbooks forever if you do not save your passwords
properly.

 

Mark Workbook as Final

Choose the Mark as Final option when you prefer to be slightly less strict
with securing your spreadsheets in Excel. You must activate editing as well
after marking an Excel spreadsheet as the final document, which changes the
document to read only option. Navigate to "File", click on the "Info button",
and choose "Protect Workbook" again to set a document to read only option.
You can mark the file as the final document, by selecting Mark as Final and
selecting the box.

 

Secure Personal Sheets and the Workbook Layout to Prevent
Removing or Adding More Sheets 

This will protect any Spreadsheet from being rearranged, removed, or added
in an Excel workbook, securing the structure of your workbook. If you prefer
to enable anybody to have access to your workbook but still restrict the
modifications they can make to your data. Through restricting the user's
ability to modify the sheets of the workbook and the structure of the
workbook is preserved. Click on "Review" from Excel's ribbon, then choose
"Protect Workbook'' from the drop menu to permit this security.



 

Secure Excel Workbook

To secure your Excel workbook's organizational layout, click the "Review"
menu, choose "Protect Workbook", and input a password. Passwords to
change and unlock the worksheet can also be shared with preferred
individuals. Select the "Protect Workbook" tab again and enter the password
to unlock an Excel workbook.

 

Selectively Enable or Restrict Alterations to Important Cells or
Formulas in Your Excel Spreadsheets, Make Use of the
Protection Feature

Click the "Review" menu in Excel and select "Protect Sheet" a vast array of
choices will pop-up. Choose whatever option suits you and click on "Ok".
You can fine-tune ways you desire to safeguard the cells in your spreadsheet
by using windows.

 

How to Input Date in Microsoft Excel
There are various ways to input a date in a cell in Excel; these include
January 7, 2023, 7-Jan or 7-Jan-2023. Although Excel understands that you
are inputting a date when you input text like that into a cell, the date style is
automatically added to that field. Most times, Microsoft Excel formats the
recently added date in accordance with the date settings of the Window's
default, though occasionally it may retain it just as you input it.

 
Several Methods of Inputting Date in Microsoft Excel



Whenever your date entry shows on the left side in a cell due to Excel not
detecting the date you entered, try typing your date in a particular format
which is like your usual long or short date formats. The easiest way to access
these formats in Excel is by clicking on the "Home" menu, from the
"Number" section, choose either "long date" or "short date" from the drop
menu. These formats are displayed with just an asterisk in the Formatting
Cell dialog window.

 

Inputting current time and date in Excel

You can insert the current time and date in Excel as a dynamic or static
number.

 

Excel shortcuts for inputting the current date as a timestamp.

Adding a "fixed date" that won't change over time or if the worksheet is
updated is known as "timestamping". To set the current date or current time
as a fixed value which will not be updated the following day, make use of one
of these shortcuts:

 
Use the key "Ctrl +” to add the current date to a cell.
Use "Ctrl + Shift +" to input current time.
Use "Ctrl +, the Space bar, then press Ctrl + Shift +" to input the
present time and date.

 

Add the present time and date, that are regularly updated.

Choose from the Microsoft Excel date functions listed below to input the
current date in Excel for it to be accurate always:



 =NOW() adds the current time and current date to a cell.
=TODAY() function adds the current date.

 
How to Apply Microsoft Excel's Auto-populate Dates

You can always use algorithms to generate a date sequence, or you can permit
Excel to "auto date" a row or a column by applying the "AutoFill" function as
shown below when you want to input dates in a cell range.

 

Automatically Populate Per Day Date Series

Users can also use Excel's AutoFill function in prescribed manner to fill a
row or column automatically with an increasing date series which rises by a
day.

 

The Very First Cell must have the Initial Date

You can select a cell with a date by clicking on it and drag the fill tool down
or across the cells you need Excel to insert dates to. In Excel, whenever you
choose a range of cells or a cell, a tiny green box (which is the fill handle)
will appear in the bottom-right side. You can automatically fill years, months,
or weekdays automatically in a date sequence which increases by a day.

 

Excel's Pop-up Calendar Allows You to Add a Date

This can be a great idea to add a pop-up calendar in your worksheet when
you want to set up a spreadsheet for the other users and you also want to
ensure that individuals input accurate dates. Dates can be inputted by your



clients just with a few clicks of the mouse, so you can be sure that every date
is correctly typed.

 

Delete or Edit Cell Content in Spreadsheet
To control the information shown in Excel cell, the Spreadsheet author and
partners with Editor or Administrator can have access to the sheet, and they
can decide to delete, update, or add to the cell content.

 
Input Data into a Cell

To input the data, select a cell and type in the data. Furthermore, you may
copy data and paste data into cells. A cell that already has data will be
overwritten once you type into it. The kind of information you can input in
the cell depends on the kind of column. For instance, if such a column is a
pop-up list kind, you can choose an option from the list by selecting on a cell.
You can also click on a cell and choose a date from a calendar if a column is
a date kind. 

 
Delete Column Content

To select the top column header, click on it. Click "Delete" or " Backspace"
keys. This will totally empty every cell's column, and the column itself will
not be deleted.

 
Delete Row Content

To delete all the row content; select the number of rows to its left and
highlight the rows. Click "Backspace" or "Delete" from your keyboard. Apart



from deleting the row, it will also empty all its cells of all data.

 
Delete Cell Content

To delete the current cell contents, choose a cell or more cells, then click 
"Backspace" or "Delete" from your keyboard.  Additionally, you can select 
"Clear Contents" by right clicking a cell.

 
Edit Cell in Spreadsheet

Data in a cell is either edited manually or through reviewing the cell contents
in a form. Use key F2 to enable a cell to be modifiable. Select the preferred
formatting feature from the menu on the left after choosing the cell you
would like to modify the formatting.

 

EXCEL MAIN FUNCTIONS AND
FORMULAS

 

What are Functions and Formulas in Microsoft Excel?



 

Using a particular value in a specified order, the standard formula function in
Excel is used. To use a function, you can quickly decide the minimum value,
maximum value, average, count, sum for a group of cells. For instance, the
SUM function in cell E5 determines the total of the values in the range
E3:E4.

 

A formula in Microsoft Excel can run on information from a wide cell range
of operators and addresses. For instance, formula =E3+E4+E5 produces the
total of the data in cells E3 through E5. A formula with real numbers can
appear like this: =10*5. 

 

Time and Date Functions
 

 

Time and Date values can be modified by using these functions, and these
include YEAR, MINUTE, MONTH, DAYS and DATE which are all under
Date and Time category. The table below lists a few basic time and date
functions.



 

S/N      FUNCTION USAGE                    
      DESCRIPTION                                            

1      YEAR      =YEAR(“08/06/2023”)      A date value is used to return the
year.                             

2      MINUTE        =MINUTE(“10:20”)      A time value that returns the
minutes                               

3      MONTH      =MONTH(“8/6/2023”)      A date value is used to return the
month.                              

4      DAYS      =DAYS(F9,F9)      Estimate how many days there are between
two dates.                     

5      DATE      =DATE(2023,6,8)      Microsoft Excel code generates a
number that matches the date.

 

Basic Functions

 



S/N   FUNCTION    USAGE             DESCRIPTION                                    
      CATEGORY            

1       NOW              =NOW()      Provides the system's current time and
dateTime and Date

2       DAYS              =DAYS(B3,A3) Provides the days between two
dates         Time and Date

3       AVERAGEIF   =AVERAGEIF(C2:C6,”Yes”,B2:B6) Calculates a range
of cells which meet the required specification are averaged       Statistical      

4      SUMIF               =SUMIF(G5:G9,”>=1000″,F5:F9)  Adds every value 
in a cell group which matches a special criterion            Trig and Math

5      LEN               =LEN(A3)     In a string text, it provides the number of 
characters   Text 6      COUNT               =COUNT(A2:A6)  Calculates how 
many cells are in a group of cells Statistical

7      AVERAGE     =AVERAGE(B2:B4)      Computes the average value in a 
group of cells      Statistical      

8      MAX                 =MAX(F3:F9)      Identifies the highest value within a
group of cells Statistical      

9      MIN            =MIN(C6:C3)          identifies the smallest value within a 
group of cells            Statistical      

10      SUM            =SUM(D2:D4)           Adds every number in a cell group    
Trig and Math

 

VLOOKUP Function
To provide a number within the same row from a specific column, the
VLOOKUP function performs a vertical look up in the top left-hand corner.



A serial value section in the household supply budget identifies a particular
product in the budgeting. The VLOOKUP tool can also be used if you have
enough item product code and need to know the description of the product.
For example: "=VLOOKUP" (D6, B2:C3, 2, FALSE) (D6, B2:C3,2,FALSE).

In the above example:

 
"=VLOOKUP" draws the vertical look - up function. 
The value to search within the left-most column is determined by
"D6".
The table collection that contains the data is specified by "B2:C3".
The column value with the row number which the VLOOKUP
function would return is determined by the value "2".
False indicates to the VLOOKUP function that we have been
searching for an actual match of the specified look-up number.

Numeric Function
 

 

These actions are carried out on numerical data. A few of the typical
numerical functions are displayed in the table below.



 

S/N  FUNCTION         DESCRIPTION      CATEGORY        USAGE

1     ROMAN       Change a value to roman numerals               Trig and 
Math               =ROMAN(2000)

2     MOD       Divides two digits and returns the remainder Trig and Math       
  =MOD(9,2)

3     POWER       Returns the outcome of raising a numerical value to a 
power   Trig and Math     =POWER(3,9)

4     PI      Returns the PI(π) math function's value       Trig and Math         
=PI()

5     MEDIAN       Returns the value placed in the center of the specified set
of numbers Statistical  =MEDIAN(6,8,3,4,5)

6     ROUND      A numeric value is rounded to the given number of decimal
 places Trig and Math      =ROUND(6.13377,4)

7     RAND       An integer value between 0 and 1 is generated   Trig and 
Math      =RAND()

8     ISNUMBER    Returns If a given value is a number, True, or else False    
  Information    =ISNUMBER(D5)

 

String Functions

 



 

Textual data editing is done using these key Excel functions. A few of the
basic string functions are outlined in the table below.

 

S/N      FUNCTION    DESCRIPTION        CATEGORY               USAGE

1      REPLACE    Removes a section of a text and replaces it with another 
text       Text       =REPLACE(“Roofing”,2,2,”xx”)

2      FIND              Returns the initial placement of one string of text from
 insideanother      Text     =FIND(“oo”,”Roofing”,1)

3      ISTEXT        If the given argument is String, returns 
True      Information   =ISTEXT(value)      

4      MID              A string's mid letters can be recovered from an initial point 
and length provided in the string  Text     =MID(“GURU99”,2,3)

5      RIGHT         Returns a specific number of characters from a string's end 
which is the right side       Text      =RIGHT(“GURU99”,2)

6      LEFT         Returns a specific number of characters from the beginning 
which is the left side of a string    Text      =LEFT(“GURU99”,4)

 



Add Functions
 

 

 

The structure of every function is the same. For instance, SUM (D2:D6). This
function's title is SUM. You will provide Excel with the cell range D2:D6 as
entry, as indicated by the text contained in brackets above which is the
arguments. The numbers in cells D2, D3, D4, D5, and D6 are merged using
the SUM function. Remember which function to use for every job and which
arguments to use are challenging.

 

You can add the right arguments and formula for your requirement by using
the "Insert Function" dialog box. You can access the Insert Function dialog
box, by clicking on "Formulas", click "Insert function", search the function
you want, input a short explanation of what you want the function to achieve,
and then select "Go". From the "Select a Function" drop-down menu, you
will see a list of functions which will probably suit your requirements and are
based on your description.

 



You can also choose a type from the drop menu, and click "OK" or carry out
any of the following steps:

 
"Select All": The "Select a function" tab will show all functions
alphabetically.
"Select a Function Category": The "Select a function" option will
show the functions in that category alphabetically.
"Select Most Recently Used": The "Select a function" option will
show the functions you have added recently in alphabetical order.

 

Few vital Excel Function from the "Function Library" menu includes:

 

 
Mathematical

POWER: The power of a numeral value raised to the next number will be
returned.

SQRT: This will give you a number's positive square root.

 
Logical



NOT: This will return a logical number which is the opposite of any logical
number or statement that the user provides.

AND: Review a wide range of user-defined situations and return.

TRUE if ALL conditions are valid or FALSE if not valid.

OR: Examine a range of user-defined criteria and return TRUE if

ANY of them are TRUE, or FALSE if otherwise.

 
Statistical

COUNTIF: This will show how many cells within a specific range suit a
particular requirement.

SUM: This will return the total of the numbers in the specified table.

MAX: From a set of specified numbers, "MAX" will return the highest value.

 
Time and Date

TODAY: This will provide the current date.TIME: This will provide a time
based on the second, minute and hour provided by the User.NOW: This will
provide the current time and date.

Text Functions

RIGHT: Return a certain number of characters from the finish of a given text.

LOWER: All the characters in a string of text are converted to lowercase.

UPPER: All the characters in a string of text are converted to uppercase.

CONCATENATE: This will combine two text strings or more text strings
together.



LEFT: A specific number of characters from the onset of a given text string
will be returned.

 

Common Errors to Avoid in Excel
In this section, I will list and explain ten common errors you should never
make in Microsoft Excel and how to work in Excel without running into
problems.

 
Merge and Center Cells

Merging and centering cells have the frustrating problem of interfering when
choosing a set of cells. Furthermore, they can make calculation errors and
hinder you from sorting and copying and pasting of data. Make use of the
Centre Across Selection method as a fix.Even though it has the exact
appearance as merged cells, it does not restrict it anyway. The selected and
merged cells make use of the center across method which seems identical.

 
Non-Tabular Layout

Data presented incorrectly constitutes one of the commonest errors I find. We
have Tabular and Non-Tabular data layout. Tabular Data can be used by
unpivoting the year columns in Power Query, and it is easy to rectify this data
arrangement.

 

This is the best format to use by separating the year column from the values
column. Non-Tabular data layout seems to be relatively good; the year data
are spread over several columns. Whenever you do this, it is challenging to



use the installed tools, such as features, and pivot tables which are created to
interact with data in a tabular layout.

 
Format Date as Text

Date that are formatted as a text, that generally come from documents
transferred from external devices, may be challenging to distinguish because
they seem the same on the cell's face as well as in the formula bar. Dates that
are correctly inputted will show their date bar code when you use the
“Ctrl+Backspace” keyboard shortcut.

 

Since you cannot use dates as references in calculations, dates formatted as
text are problematic. The text dates, for instance, give me an error whenever I
attempt to figure out the number of days between the first dates and last
dates, but still the proper date serial numbers calculate it accurately. Text
dates can be changed into date serial numbers as an alternative. You can
correct dates that are formatted as text in Microsoft Excel in various ways. 

 
External Links Mistakes

A safe option is to use Power Query to retrieve data and transfer it into your
document if you want to reference data from an external file. When you do
this, your formulas will not be corrupted, and you may update the query
without accessing the external file.

 
Format the whole Rows or Columns



Formatting an entire row or column is simple and quick, it only increases the
number of redundant data in your document, expanding the size of your file
beyond what is needed. Use “Ctrl+T” to format any data in an Excel table or
format from the style library. You can also select "None" (which is found on
the top-left option in the style gallery) if you want to create your unique
format. Whenever you use formats to a table's column, every fresh row you
add will also get those formats by default.
Format Data to Encode

Data is commonly encoded by using colors of the cell fill. This is an issue 
since it is impossible to count information which matches a fill color because 
formulas cannot refer to the color of a cell's fill.  Add numbers or text in the 
cells and conditional format to highlight the cells with the defined value: The 
numbers on the cell's appearance are concealed due to the custom number 
formats you used in the conditional formatting rule. You can also use a 
custom number as a reference when determining the count.
Color Formatting in Excel

It's not important to highlight data with flashy colors. Flashy colors make
your viewer uncomfortable and the data difficult to read, rather than
attracting attention to the data. Use complementing colors and keep it simple.
Several Records in a Single Cell

Although it can be tempting to enter as much information as you can into a
cell, using these makes it hard to use formulas to analyze your data. It is
simple to create a formula to count the number of days in a layout with
different cells for each data.
Sum Ranges with Missing Cells



There are times when adding additional rows of data for SUM calculation can 
affect the new row to be omitted from the SUM.  To get the final cell 
reference in the range, use OFFSET.
Use .xls kind of file

From Excel 2007 till present, the .xls file type was updated with .xlsx;
nonetheless, most third-party applications still provide the option to export
data to .xls files, that are modeled on the Binary Interchange File Format and
store data in the binary format. XML data is saved and stored in ZIP files for
.xlsx files that are based on the Office Open XML style. Simple unzipping
the .xlsx file will enable you to view the internal structure and files.

Create a duplicate of the document and save it as an .xlsx file format as a
workaround.

 

 



DATA FILTERING AND SORTING IN
MICROSOFT EXCEL

In this chapter, I will describe the filtering and sorting of data in Excel. The
choices of sorting data varied. You can group data based on similar
characteristics, like:

Format (for example cell color)
Times and dates (oldest to newest, or newest to oldest) 
Numbers (high and low, or low to high) 
Text (Z to A or A to Z) 
Data can be sorted across several rows or columns in addition to
by individual characteristics.
You can also sort data by using custom lists.

How to Filter Data in Excel

 

To concentrate on the data you desire to see, you can always use filters to
temporarily hide a portion of the information in a column. You can define
exact matches, comparisons ('less than, greater than'), or data that does not
suit basic criteria for filtering. These operators can be used to compare two
values. The output of applying these operators to compare two values is a
logical value, which can only be either FALSE or TRUE. The table below
consist of Excel's comparison operators:



 

Comparison operator   Example   MeaningResult(C1=1,G1=2)

<>                           C1<>G1          Not equal to               TRUE

<=                            C1<=G1          Less than or equal to   TRUE

>=                          C1>=G1          Greater than or equal to   FALSE

<                          C1<G1           Less than                 TRUE

>                          C1>G1          Greater than             FALSE

=                          C1=G1           Equal to                    FALSE

How to Sort Data in Excel

 

Sorting data in Microsoft Excel can be done through the steps below:
Choose a cell from the column you wish to sort.
Navigate to the "Data" menu and select "Sort and Filter" from the
drop-down menu.
 Click on the "Sort" icons either from Z to A to sort your data in
descending order or A to Z to sort your data in ascending order.
Click on the "Sort" option to view additional options for sorting
data.



To use the "Advanced Filter", navigate to the "Data" tab, from the
drop-down menu click on "Advanced" from the "Sort and Filter"
section.

Pivot Tables

 

Excel has pivot tables by default. They make it easy and fast to sort and
analyze huge amounts of data. Using only a little level of work, pivot tables
let you get answers to a few simple queries about your data from input tables
having thousands, hundreds, and tens of rows.

 

Pivot table is also used to sort common sales data, to achieve the following:
Referencing
compile an order breakdown report by type of item, month, and
client.
give a summary of the highest order value by month and customer.
calculate the usual quarterly earnings to a specific customer.
compile a list of sales by client based on the type of item bought.
calculate the total sales by product category.
totaling the items ordered by every customer.
calculate the total sales for each customer.

 



HOW TO USE GRAPHS AND CHARTS
INEXCEL?

 

One of several best methods to present data in an acceptable and simple way
is by creating graphs and charts. In Excel, you can build more than only line
or bar charts. Once you know how to use each of them, you can use it to get
more meaningful information for the projects that either your team or you are
working on.

 

Type of Excel Chart

Surface chart

This chart presents data in groups of values as a three-dimensional surface.

Stock Chart

This is used to depict how stock prices have changed over a particular period.



Bubble or Scatter Chart

This shows the negative or positive relationship between two variables.      

Waterfall, Tunnel or Radar Chart

These contrast the total of different data sets.

Doughnut or Pie charts

It displays data as a percentage of the overall value.

Line Chart

This shows changes over time in a way similar to bar charts.

Column Chart

This Chart also shows how data has evolved over time.

Bar Graph

Shows data frequency at varying levels or for various variables.

Area Chart

This shows the strength of a pattern among two or more data over a specific
period.

 

Other Charts include Hierarchy Chart, Statistic Chart, Maps Charts,
PivotChart, and Combo Chart.

How to Use Your Data to Build Graph in Excel



Your data should be entered into Excel.

Your data must first be inputted into Excel. It's possible that you exported the
data from a survey or marketing program. Or maybe you input your data
manually.

 

Select from the Chart and Graph choices.

Bar or Column graphs, Scatter or Bubble plots, pie graphs, line graphs and
much more are all featured as graphs and charts in Excel. Go to the "Chart"
menu after selecting "Insert" to view the graph and chart choices.

 

Highlight your information and add the preferred chart to the
spreadsheet.

The Y and X axis labels must be included with the data to create a bar graph.
The column icon in the "Charts" tab by clicking the "Insert" menu. The
dropdown pane that displays allows you to select the desired graph.

 

Change the axis of each data.

Right click on the bar graph, choose "Select Data", then choose Switch Row
or Column to edit what shows on the Y and X axes. Select "OK" at the
bottom when you are through.

 

Modify the chart's axis labels and legend size.

Based on the charts or graphs you selected, the legend and axis labels you 
used while creating your initial chart in Excel could be small.  



 

Whenever you are through with creating charts, you must make the labels
bigger and more understandable. Click on each chart's labels separately to
increase them. Then, instead of just opening a fresh Format tab, switch back
into Excel's navigation menu bar from the "Home" menu. Next, you can
reduce or increase the axis and legend labels of your chart as preferred by
using the font size and type selection options.

 

Adjust data color and layout.

Tap on the bar chart and choose the "Charts Design" option to modify the
legend and label layout. Here, you can select your preferred layout for the
chart label, axis label and legend.

 

Edit the Y axis measurement choice.

Select the percentage on the Y axis of your graph to display the "Format
Axis" box and edit the kind of measurement presented there. On the "Axis
Options" box, you can show units or change if the Y-axis shows percentages
with no decimal place or two decimal places.

 

Rearrange your data.

Right click on your chart and tap "Select Data" to open the same selection
box you will use in adding preferred chat to your spreadsheet. It will arrange
the data so that the respondents' replies are shown in reverse order. To reverse
the arrangement of your information on the graph, arrow up and down this
time.



 

Name your Graph.

The title that shows shortly after creating your chart is "Chart Title".   Click 
"Chart Title" to display an editing cursor and change this name. The name of 
your chart would then be completely changeable. After you have chosen a 
name you prefer, choose "Home" from the top menu bar, and apply the
formatting options for the type to give it the priority it requires.

 

Export Chart or Graph

You can export a graph or chart as a picture if it is simply how you want it
after having screenshotted it in the spreadsheet. Through this approach, you
may produce a clear picture of your graph that can be added to a PowerPoint
or Canva presentation, along with other visual templates. Right click on the
Excel graph select "Save as Picture" to save it as a picture. Name the image
of your graph andchoose where to save it on your computer and select the file
format you desire to use in the dialogue box.

Graphs and Charts Best Practices
Use a dynamic name for your chart.

A cell in a worksheet can be connected to the name of your chart to update it.
It is a little bit of a hack that will make you appear smart to your customer or
company. The ideal uses for dynamic names are for constantly updating data,
such as everyday data inputted manually, or data recovered from a database
and pasted into Excel.

 

Make customized charts.



You are not restricted to the several themes that Excel offers. Create a chart
by using your brand's colors and save it as a theme if you want your data to
match your brand. 

 

View and use other Themes in Excel

Despite Excel's great chart editing features, most users rarely change it from
the default "Office" configuration. By clicking "Page Layout" select
"Themes" (for Mac: navigate to "Home" and click on "Themes") and select a
new theme from the drop menu. 

 

Tidy your axes.

Always make sure that your axes are always clean.

 

Avoid making people to tilt their head while interpreting your data

This makes it difficult and prone to mistakes when interpreting data. If your
axis labels are longer, it is preferable to make your chart larger so that they
may be presented horizontally, or even better, use a bar chart rather than a
column chart.

 

Always sort your data before creating a chart in Excel

Unsorted data results in charts that are far more complex to understand and
read.

 

Include a descriptive title to your Chart.



Everything you are trying to communicate is clear to you when you are the
one bringing the data altogether. However, it is not always clear to others
who will strive to comprehend what you are trying to convey. Click your
chart and then click "Chart Tools" select "Layout" choose "Labels" and click
on "Chart Title" to add a chart title. To add a title to your chart on Mac click
on " Charts" select "Chart Layout" choose "Labels" and tap "Chart Title".

 

With just a set of data, you can remove legends.

It is not necessary to use the legend that Excel displays if you are simply
showing one data on a chart. Simply ensure the chart title contains the metric
you are presenting.

 

Reposition the legend.

The legend should generally be placed at the bottom or top of a chart. I
usually position the legend above instead of below, but when there is too
much data at the top or if there is a pie chart. To reposition it, simply access
the formatting menu and select the preferred place from the Legend Options
category which is known as Placement on a Mac. 

 

Your chart background noise should be removed.

It is necessary to remove the noise and concentrate on relevant information
when presenting data because the background noise keeps you from focusing
on the important things.

Data Charting Methods in Excel



Control a missing and zeros data in your chart.

By choosing the chart series, select "Chart Tools”, choose "Design Tab", click
on "Select Data", click on "Hidden and Empty Cells", and select "OK" to
control how missing data or zero values are presented in a chart.

 

Excel charts has various colors that can be used.

Excel will continually use the exact same color for each bar when plotting a
chart only with a range of data. This can be changed by choosing the series,
using right click, and choosing "Format Data Series", followed by "Fill". If
the chart only contains a series, the options to change the color of each point
will be provided.

 

Title your chart smartly

The data of a worksheet cell can be used as the chart's title. Navigate to
"Chart Tools", choose "Layout" menu, and click on "Chart Title”' to title and
position your chart title. Always make sure you title your chart smartly.

 

Grow your chart automatically.

If you possess data which will change over time, you may build your chart to
develop as additional data is included to your data storage. To achieve this,
choose the data and click on "Format as Table" from the "Home" menu of the
ribbon after choosing the data. When you use the table information as the
base for your chart, your chart will enlarge automatically when more data is
included because your data is presented as a table.

 



Create a combined chart.

Choose the preferred data, then create the basic chart, like a column chart.
Then click on "Chart Tools", choose "Design Tab" and select "Change Chart
Type" and choose the second chart type, choosing the data that you desire to
present in a different manner, like a line chart. Column and Bar charts, for
instance, cannot be effectively merged but a column and line chart can be
combined.

 

Plotting on the second axis of a chart

Small data, like percentages, will always get lost and become unreadable
when plotted against bigger data, such as millions. Plotting the percentages
on the second axis will enable you to identify the solution to the problem.

 

Bigger bars

It is possible that your chart's bars are abnormally thin whenever you plot 
data that are date-based.  To correct this, click on the "X axis" of the chart, 
and select "Format Axis" from the menu bar. Select "Text Axis" by first 
selecting the "Axis Options". This adjusts the axis's layout, resulting in bigger 
bars. The spacing width can then be adjusted to make it bigger if needed.

 

Change the column spacing and overlapping.

Right click any series on the chart and select "Format Data Series" to change 
the space between columns or the overlap between two chart series.  Use the 
Series Overlapping option to overlap the series by moving toward 
Overlapped or to separate the series apart by dragging toward Separated.



 

Excel chart can be saved as a picture.

The best way to save a chart as a picture is to size the worksheet's chart such
that it would have the perfect size. Click on "File" select "Save As", and
select the place to save the file, choose Web Page from the "Save As Type"
drop menu, input a title, and then click on "Save".

 

Use the white and black patterns.

The sequence to change can be selected from the drop menu at the top-left of
the ribbon by choosing a chart and selecting "Chart Tools" from the "Layout"
menu. Click "Fill" and select "Pattern Fill" from the Format Selection menu.
Set the background and foreground colors of a monochromatic chart to white
and black, respectively, and pick a fill pattern for the series. For the second
series, repeat the same procedure while using a different pattern.

 

MICROSOFT EXCEL ADVANCED
FORMULAS AND FUNCTIONS

 

TRIM Function



Unwanted spaces within text are tidied up using this Excel formula. For
example, you can use the TRIM function to remove spaces from the
beginning of names in a cell.
OFFSET Formula

When you combine this function with "AVERAGE" or "SUM" it can make
the calculations dynamic. It works the best when adding continuous data into
a dataset which already exists. Excel has a range in which we must provide
the number of columns, number of rows and reference cells. Under Excel's
Lookup and Reference functions, the OFFSET Function is a subset. A
collection of cells will also be returned by OFFSET. It will return a certain
number of columns and rows from a specific start range.

 

Charts and pivot tables are widely used in financial analysis. To assure that
the original data in charts or pivot tables is often current, use the OFFSET
function to create a dynamic named range. In OFFSET syntax, "cols", "rows"
and "reference" are required arguments while "width" and "height" are
optional arguments.
OFFSET Function Formula

= OFFSET(reference, rows, cols, [height], [width])
Width: The width of the returning array is given by this. The
returning range contains the same width as the reference given if it
is missing.
Height: Height of the given range is provided. The height of the
given reference argument is applied to define the given range if it
is omitted.
Cols: The number of columns between the beginning of the
supplied reference and the beginning of the returned range.



Rows: This is the rows number between the beginning of the
supplied reference and the beginning of the returned range.
Reference: This is a cell range that must be offset. It may consist
of several cells or a single cell.

LEFT, MID and RIGHT Formula

This formula can be applied to split a particular substring out of a text string.
The RIGHT formula too is used in the same manner. The difference is that
you will have to view the text from the string's right. The start position and
length of the preferred text string must be provided in the case of an excel
MID function.

 

Excel's LEFT function is used to cut out a specified set of characters from a
string beginning on the left side. The RIGHT function cuts out a certain range
of characters beginning on a string's right side. It uses the very same
arguments as the LEFT function, number, and text character. The MID
function accepts an inputted string and extracts a specific number of
characters beginning at a specific location. 
VLOOKUP Formula

This is one of Excel's most frequently used formulas. The major reason for
this is the ease of using this formula and the way it can be used to look up a
particular value from separate tables, each of which includes a standardized
variable.
CONCATENATE Formula

This Excel function is one of the formulae that has a wide range of uses. It
helps to combine various text strings into a text string. CONCATENATE
Formula: =CONCATENATE(text1, [text2], …). Text1 is a required argument
which is the first item to be joined. These items can be a number, cell



reference or text value. Text2 is also a required argument which adds text
items that you want to merge.
SUMIF Formula

This formula filters all the observations according to specific criteria before
adding them all together. Whenever one cell matches a single condition, the
Excel SUMIF function delivers the total of those cells. Text, numbers, and
dates can all be subjected to conditions. For partial matching, the SUMIF
function supports wildcards (*,?) in addition to the logical operators (=, <,>).

 

The SUMIF function adds the values of cells in one range that meet one or
more conditions. To total cells based on numbers, text values and dates use
the SUMIF function which is a commonly used function. SUMIF Syntax:
=SUMIF(range, criteria, [sum_range]). Sum_range: Range to sum which is
optional. Cells in range are merged if omitted. Criteria simply means the
criteria to use. Range is to apply criteria to range.
IF OR Formula 

Like this, if any of the various conditions has to be met, you can use Excel's
OR function in place of the AND function. The IF function provides a lot
more significance when used with logical operations like NOT< OR and
AND because it permits combining various conditions to be examined.
Incorporate the OR function in the logical test of IF to analyze two or even
more conditions and return a result when any of the conditions is TRUE and
a separate outcome when all conditions are FALSE. IF(OR(condition1,
condition2,...), value if true, value if false) entails carrying out an action if a
cell is "this" OR "that," and another if it is not.
IF AND Formula 



The IF's common syntax is known to all of us. To build a new field
depending on the limitations in an existing field, use the IF formula. When
using AND to produce a flag based on several columns, you can have a wide
range of limitations or conditions. The IF function appears to be one of those
things in the world that is infinite and finite. Thus, you must merge the IF and
AND functions in a formula to create the IF AND argument.

 

The formula is as follows: IF(AND(condition1, condition2,...), value if true,
value if false), which implies taking action if conditions 1 and 2 are both true;
if not, do something different. You are not restricted to using just one logical
function in Excel IF formula. You are permitted to merge the OR, AND, IF,
AND and other functions to carry out the necessary logical tests on different
combinations of response to variations.
MATCH Formula

To build a new field depending on constraints in an existing field, use the IF
formula. Using AND, you will generate a flag depending on several columns
with a range of constraints or conditions.
INDEX Formula

By giving the number of columns, rows, or both, you can apply this formula
to get the number of a cell in each table.

VLOOKUP Formula in Excel
Whenever you are searching for a specific piece of information in a dataset or
table, the VLOOKUP Function can be used to extract the necessary
information or data. The VLOOKUP function instructs Excel to find a certain
piece of information in a table or set of data and provides corresponding



information about it. The formula for VLOOKUP is
=VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup])

 

VLOOKUP Formula Arguments

Range-lookup

This is an optional argument which specifies what will be returned if the
function cannot locate an exact fit for the lookup value. Whenever the
parameter is set to either FALSE or TRUE, the following results will be
achieved:

FALSE: Failure to find an exact match or exact match, will result in an error
being returned.

TRUE: Using the closest match just below lookup value in the absence of an
exact match.

 

Col_index_num

This is a required argument which specifies the column value in the given
table array you wish to retrieve a value from.

 

Table_array

This is a required argument in which the data array to be searched is the table
array. The leftmost column of this array is where the VLOOKUP function
looks.

 

Lookup_value



This is also a required argument. This identifies the value in a table's first
column that we want to search up.
VLOOKUP Uses

Sort the data.

Making sure your data is organized and suitable for using the VLOOKUP
function is the very first stage to using it properly. The data you would like to
look up must be located to the left of the related data you would like to
extract because VLOOKUP functions in a left to right manner.

 

Set the function's lookup conditions.

You must specify what you want Excel to look for. The very first step is to
input the formula "=VLOOKUP(," preceded by the choice of the cell
containing the data you want to look up.

 

Inform the function of the search area.

You must choose the table that contains the data, and you will instruct Excel
to look for the data you choose in the previous step in the leftmost column.

 

Specify which column will contain the data.

Excel needs to know what column the data has you want the VLOOKUP to
generate. Excel requires a number which matches the table's column number
to execute this.

 

Approximate or exact match



By adding "True" or "False" in the function, you also can tell Excel whether
you are searching for a close or an exact match. When searching up a
particular number that may not be included in the table, for instance the
number 8.226, an approximation would be helpful. Excel in this instance, will
search for the closest number to 8.226, even if this number is not in the
database. This will ensure that errors in the VLOOKUP formula are
minimized.

INDEX Formula in Excel
A selected cell from a given range or an array is returned by an INDEX 
formula. In other terms, you can use the INDEX formula when you are 
interested in an element's real value but can calculate where it stands in 
relation to other items in the range. This function is flexible and smart.  In 
Excel, INDEX function comes in two different kinds which are reference and 
array form.
Syntax uses of INDEX Function

INDEX Formula: INDEX(array, row_num, [column_num])
Column_num: Identifies the column in which a value should be
returned. Row number is necessary if column number is left out. 
Row_num: Is the index into the array's row where a value should
be returned. Column number is important if row number is left
out.
Array: A set of cells referred to as a range or a table.

For instance, the formula =INDEX(B2:C4, 7, 2) will return cell C4, which is
located at the meeting of the 2nd column and 7th row in the range B2:C4.

 

INDEX array form: INDEX(reference, row_num, [column_num],
[area_num])



Area_num: This is a selection parameter specifying which range
from the reference argument ought to be used. First range
specified in reference will serve as the outcome if the INDEX
formula is left out.
Column_num: The array form also applies to the column value
that is used to return a cell reference.
Row_num: Like the array form, it returns the range's number of
rows from which the cell reference will be returned.
Reference: This consists of a range or ranges.

For instance, the formula =INDEX((A5:E6, C4:B3), 2, 5, 3) will return cell
B3 value, that is at the meeting of the 5th column and 2nd row in the second
part (C4:B3).
Basic Uses of Excel INDEX Function

Use the Excel INDEX formula, to choose one range from a set of ranges.

The flexibility of the INDEX function to choose a range from a set of ranges
is also another smart and efficient usage of the function. For instance, if you
have multiple lists, each containing a distinct number of elements, you can
use a single formula to estimate the sum or average of the values in any given
range.

 

Strong INDEX or MATCH with VLOOKUP

The INDEX function excels when you execute lookups vertically. If you have
used the VLOOKUP function, you are quite aware of the various limits. For
instance, you can just get data from column to the left of the lookup column,
and the maximum limit of a lookup value is two hundred and twenty-five
(255) characters.

 

Dynamic range and drop list can be created by using INDEX formula.



As is often the case, you may not be aware of the precise number of rows or
columns you will need when you begin to organize your data in a worksheet.
The primary benefit of this method is that you are not required to change
each formula in your worksheet on a regular basis to make sure they
reference the right ranges.

 

Applying INDEX Function with additional functions (MIN, MAX,
AVERAGE, SUM etc.)

An INDEX formula does not only return numbers, it returns a reference to
the cell that has value because the outcome of an INDEX formula is a
reference, you can apply it to build a dynamic range in other functions.

 

Having every value in a column or row

INDEX function has the capability to retrieve a data array from a column or a
row in contrast to getting a single cell. Skipping the row number argument or
setting it to Zero will return all data for that column. Similarly, if you supply
an empty value or zero for column number, you will receive the full row.

 

Finding the Nth entry on a table

Use the INDEX function whenever you desire to retrieve a specific item from
a list, you input =INDEX (range, n), where range is a collection of cells, or a
defined range and n represents the item's location.

MATCH Formula
To get a lookup value's placement in a table, column, or row, use the Excel
MATCH function. This function allows partial matches with wildcards (*?)



and precise and approximate matching. To get a number at a matched place,
MATCH function is commonly used in combination with the INDEX
function.

=MATCH(lookup_value, lookup_array, [match_type]) 
Lookup_array: An array reference or a group of cells.
Lookup_value: This is a lookup array's matching value.
Match_type: Next or exact lowest (default); -1 implies next largest
or an exact match while 0 implies an exact match.

Uses of MATCH Function

1. MATCH function can be applied to find a value in an array or range.

 

2. It supports wildcards (*?) for partial matches as well as accurate and
approximate matches.

 

3. It only accepts horizontal or vertical single ranges or arrays. Nonetheless,
by presenting MATCH with the single row or column which has the lookup
value, you can use MATCH to find entries in a two-dimensional table or
range. Sometimes, you can get a matching column and row by using MATCH
twice in a single calculation.

 

4. It determines the location while INDEX provides the value at that location.

 

Notes

In connection with the INDEX function, the MATCH function is widely used
in many applications.

 



The lookup value can have the wildcards when the match type is fixed to
zero.

 

The lookup array must be arranged as stated above, match type is either 1 or
-1.

 

MATCH Function returns the first match when there are repetitions.

Only text with such a length of up to two hundred and twenty-five characters
can be used with MATCH Function in Excel.

 

When no matches are detected, MATCH provides the #N/A error.

MATCH Function in Excel is not case sensitive.

TROUBLESHOOTING

 

Microsoft Excel is an efficient tool for analyzing and storing various kinds of
data. Educational institutions, small enterprises, and some of the top
companies around the world all use it daily. Your day can be ruined, and your 
organization may even lose a lot of money if Excel returns and error, freezes 
or crashes.  However, if you are familiar with the processes for 



troubleshooting Excel, there are several simple solutions for these issues 
based on the nature of the problem. Freezing, Not Responding, or Has 
Stopped Working been Microsoft Excel's troubleshooting issues.

 

 

 

 

How to troubleshoot issues in Excel
Check that Excel is active and running.

Check if Excel is simply working on something and you will have to be
patient before you begin some of the most difficult troubleshooting processes.
If Excel is open, it can be seen in the taskbar at the bottom of the window. 

 

Use the Safe Mode to start Excel.

You can begin the application in safe mode to avoid having any of the
starting problems. Holding down the "Control" (Ctrl) key while launching
Excel or using excel.exe /safe into the command prompt will activate Excel
in safe mode.

 

Remove the Add-Ins in Excel

The next process is removing add-ins in Excel, and this is achieved through
the following steps: 

Navigate to the "File" menu.
Select "Options" from the drop-down menu.
From the "Option" tab, choose "Add-Ins".



Choose "Go" which is next to the "Manage list" tab.
Click on "Ok" after removing the Add-Ins.

 

Update Your Applications Regularly

Excel changed whenever it started working one moment and quit functioning
the next moment. It is likely you have missed a crucial update. To find out if
this fixes your problem, there are some items you can check and update.
Firstly, is your Windows installation updated? Install the most current
suggested updates and changes if you have not already done so. Secondly, do
you have any Excel updates? Download and update them as well if they are
available. After all these updates have been completed, restart your computer,
and proceed to launch Excel once again.

 

A third-party software should be examined for issues.

Virus scanning and add-in disablement can make Excel stop functioning. For
instance, several Excel files are created by external programs. It might not
function or work properly if such files are not created appropriately. Simply
open the file in a software different from the third-party one to confirm this.
If it does, there is a fault with the file instead of the Excel software.

 

Run a Selective Startup to Detect Issues

Procedures, applications, and services could be incompatible with Excel.
Other programs and services usually launch with Windows, a few of which
could cause problems. By conducting a selective startup, also known as a
"clean boot" you can assess how such exist and what they represent. There



seems to be one further thing you can try which is fixing your office software
if this method was found to be conflict free.

 

Fix your Office Software

Your Excel application may also have suffered a terrible malfunction and
requires help to resume operations. However, the self-repair function in
Office programs can usually be used to fix them. The steps may be different
based on the base operating system.  Any of the above Excel troubleshooting 
processes can help you get back on track. 

How to Troubleshoot Formulas in Microsoft
Excel

What will happen if Excel is presenting more technical issues, like a formula
issue? It is often frustrating to deal with formulas and functions related
issues. There are basic errors which occur in Excel if you are dealing with a
worksheet or just a problem in general. The below Excel troubleshooting
process will help you in identify and solve spreadsheet formula issues:

 
Make Use of Error Checking

Excel has a setting related to this that you may not or may have enabled. It is
usually a good idea to have it activated to be conscious of errors and can even
receive support where necessary. Navigate to the "File" menu, choose
"Options", and then click on "Formulas" to activate it. "Enable Background
Error Checking" must be checked and click on "OK".
Discard Basic Mistakes



Everyone will have encountered one or two of these mistakes: Failing to
close your parentheses, using a colon in a cell range instead of a semicolon or
forgetting to begin a formula with the equal sign. These are simply just a few
instances of basic mistakes that could enable Excel to provide a solution that
you do not understand or want. Other mistakes include trying to divide a
number by zero and inputting the dollar sign ($) in the inappropriate cell. 
Excel can Help.

Excel will provide you tips and recommendations whenever you input
formulas that obviously contain mistakes. Excel's guidance can often help
you in preventing or fixing mistakes. 
Use the Auditing Tools in Excel

Excel offers its users a range of auditing tools which can be used to detect
and fix calculation errors. Search for the tools in the "Formula Auditing
Group" section by selecting the "Formulas" menu. Trace Precedents and
Trace Dependents visually help you to know which worksheet cells go into a
formula. Your complete worksheet will be checked by error checking. A
formula's variables will be analyzed by "Evaluate Formula", that will then
notify you of any areas that may be causing problems.

 



MICROSOFT EXCEL FREQUENTLY
ASKED QUESTIONS (FAQS)

What is the easiest way to access a specific section of a worksheet?

Just use the name box to quickly go back to a specific section of the
worksheet.

 

What function does "Name Box" in Microsoft Excel's offer?

By inputting a cell address or range name in the name box, users can go to a
certain area on the worksheet.

 

How can a fresh Excel worksheet be added?

The "Insert worksheet" menu is found at the bottom of the screen to add a
new worksheet in Excel.

 

Describe Ribbon

The word "ribbon" is defined as a region at the top of the software that
occupies the Microsoft Excel menu items and toolbars.

 

Can You Freeze the Top Row in Excel?

Yes, you can freeze the top row in Microsoft Excel by selecting the "View"
menu from the ribbon, then choose the "Freeze Top Row" box under the
"Freeze Panes".

 

What is the best way to add the Fahrenheit sign to a worksheet?



You can use the keyboard shortcut "ALT" plus 0176.

 

How can Excel formulas be seen in cells?

Use the "Control (Ctrl) + ~" which is a keyboard shortcut.

 

How can I sort data horizontally in Excel?

Microsoft Excel has an "Options" menu which allows you to fix the sort from
Left to Right when you click on "Ribbon”, select "Data" and choose "Sort".

 

Why does the text on my cell look like #####?

It indicates that such a cell is not big enough to show the full text. To expand
the column, pull the right cell border and drag it to the right.

 

Instead of seeing a result, I am seeing a formula in Excel.

Navigate to the "Formulas" and disable the "Show Formulas" option under
the "Formulas Auditing".

 



 

CONCLUSION
In a nutshell, Microsoft Excel has a lot of advantages, and it is used for
various purposes, features, and functions. Excel is the perfect means for
storing both small and large data, used for cleaning and transforming data,
automating with coding, template usage to make your work easier and faster,
easy printing of reports, visualization, or presentation of data with graphs and
charts, has every data analysis tools that can be used to analyze data, can also
be used to calculate etc.

 

Excel is very simple and easy to use, you can import and export data with
ease, it can be used on different devices such as Mac, Windows, iOS, and
Android, and it also has multiple spreadsheets. You can use Microsoft Excel
to return the result of an argument or statement by using the Formulas and
Functions. It is not a stressful application, easily accessible without issue and
it is not only use by data analysis alone, everyone uses Excel, and it is also
used in different settings such as organizations, companies, schools, offices
for various reasons like project management, business administration,
program management, office administration, operation management,
accounting, contracts etc.
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